AccessData Legal and Contact Information

Legal Information

AccessData Group, LLC makes no representations or warranties with respect to the contents or use of this documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, AccessData Group, LLC reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any person or entity of such revisions or changes.

Further, AccessData Group, LLC makes no representations or warranties with respect to any software, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, AccessData Group, LLC reserves the right to make changes to any and all parts of AccessData software, at any time, without any obligation to notify any person or entity of such changes.

You may not export or re-export this product in violation of any applicable laws or regulations including, without limitation, U.S. export regulations or the laws of the country in which you reside.

©2010 AccessData Group, LLC All rights reserved. No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

AccessData Group, LLC.
384 South 400 West
Suite 200
Lindon, Utah 84042
U.S.A.
www.accessdata.com

AccessData Trademarks

○ AccessData® is a registered trademark of AccessData Group, LLC.
○ Distributed Network Attack® is a registered trademark of AccessData Group, LLC.
○ DNA® is a registered trademark of AccessData Group, LLC.
○ Forensic Toolkit® is a registered trademark of AccessData Group, LLC.
○ FTK® is a registered trademark of AccessData Group, LLC.
○ Password Recovery Toolkit® is a registered trademark of AccessData Group, LLC.
○ PRTK® is a registered trademark of AccessData Group, LLC.
○ Registry Viewer® is a registered trademark of AccessData Group, LLC.
COPYRIGHT INFORMATION

A trademark symbol (®, ™, etc.) denotes an AccessData Group, LLC. trademark. With few exceptions, and unless otherwise notated, all third-party product names are spelled and capitalized the same way the owner spells and capitalizes its product name. Third-party trademarks and copyrights are the property of the trademark and copyright holders. AccessData claims no responsibility for the function or performance of third-party products.

AFF® and AFFLIB®

Copyright® 2005, 2006, 2007, 2008 Simson L. Garfinkel and Basis Technology Corp. All rights reserved.

This code is derived from software contributed by:
   • Simson L. Garfinkel
   • Olivier Castan

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement:

   This product includes software developed by Simson L. Garfinkel and Basis Technology Corp.

4. Neither the name of Simson L. Garfinkel, Basis Technology, or other contributors to this program may be used to endorse or promote products derived from this software without specific prior written permission.

   THIS SOFTWARE IS PROVIDED BY SIMSON L. GARFINKEL, BASIS TECHNOLOGY, AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL SIMSON L. GARFINKEL, BASIS TECHNOLOGY, OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

AFF® and AFFLIB® are a registered US trademarks (US 3232830 & US 3232831) of Simson Garfinkel and Basis Technology Corp.

The terms of this license can be modified by Simson L. Garfinkel or Basis Technology Corp.

AYENDE RAHIEN

Copyright © 2005 - 2009 Ayende Rahien (ayende@ayende.com)
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of Ayende Rahien nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

**DOCUMENTATION CONVENTIONS**

In AccessData documentation, a number of text variations are used to indicate meanings or actions. For example, a greater-than symbol (>), is used to separate actions within a step. Where an entry must be typed in using the keyboard, the variable data is set apart using [variable_data] format. Steps that required the user to click on a button or icon are indicated by *italics*. **Bolded** text indicates a label or non-interactive item in the user interface.

A trademark symbol (®), ™, etc.) denotes an AccessData Group, LLC. trademark. Unless otherwise noted, all third-party product names are spelled and capitalized the same way the owner spells and capitalizes its product name. Third-party trademarks and copyrights are the property of the trademark and copyright holders. AccessData claims no responsibility for the function or performance of third-party products.

**REGISTRATION**

The AccessData product registration is done at AccessData after a purchase is made, and before the product is shipped. The licenses are bound to either a USB security device, or a Virtual CmStick, according to your purchase.

**SUBSCRIPTIONS**

AccessData provides a one-year licensing subscription with all new product purchases. The subscription allows you to access technical support, and to download and install the latest releases for your licensed products during the active license period.
Following the initial licensing period, a subscription renewal is required annually for continued support and for updating your products. You can renew your subscriptions through your AccessData Sales Representative.

Use LicenseManager to view your current registration information, to check for product updates and to download the latest product versions, where they are available for download. You can also visit our web site, www.accessdata.com anytime to find the latest releases of our products.

For more information, see Managing Licenses in your product manual or on the AccessData web site.

**ACCESSDATA CONTACT INFORMATION**

Your AccessData Sales Representative is your main contact with AccessData Group, LLC. Also, listed below are the general AccessData telephone number and mailing address, and telephone numbers for contacting individual departments.

**MAILING ADDRESS AND GENERAL PHONE NUMBERS**

You can contact AccessData in the following ways:

**TABLE Contact-1 AD Mailing Address, Hours, and Department Phone Numbers**

<table>
<thead>
<tr>
<th>Corporate Headquarters:</th>
<th>AccessData Group, LLC. 384 South 400 West Suite 200 Lindon, UT 84042 USA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice:</td>
<td>801.377.5410</td>
</tr>
<tr>
<td>Fax:</td>
<td>801.377.5426</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General Corporate Hours:</th>
<th>Monday through Friday, 8:00 AM – 5:00 PM (MST) AccessData is closed on US Federal Holidays</th>
</tr>
</thead>
<tbody>
<tr>
<td>State and Local Law Enforcement Sales:</td>
<td>Voice: 800.574.5199, option 1 Fax: 801.765.4370 Email: <a href="mailto:Sales@AccessData.com">Sales@AccessData.com</a></td>
</tr>
<tr>
<td>Federal Sales:</td>
<td>Voice: 800.574.5199, option 2 Fax: 801.765.4370 Email: <a href="mailto:Sales@AccessData.com">Sales@AccessData.com</a></td>
</tr>
<tr>
<td>Corporate Sales:</td>
<td>Voice: 801.377.5410, option 3 Fax: 801.765.4370 Email: <a href="mailto:Sales@AccessData.com">Sales@AccessData.com</a></td>
</tr>
<tr>
<td>Training:</td>
<td>Voice: 801.377.5410, option 6 Fax: 801.765.4370 Email: <a href="mailto:Training@AccessData.com">Training@AccessData.com</a></td>
</tr>
<tr>
<td>Accounting:</td>
<td>Voice: 801.377.5410, option 4</td>
</tr>
</tbody>
</table>

**TECHNICAL SUPPORT**

Free technical support is available on all currently licensed AccessData products. You can contact AccessData Customer and Technical Support in the following ways:

**TABLE Contact-2 AD Customer & Technical Support Contact Information**

| Domestic Support Americas/Asia-Pacific |
|--------------------------------------|--------------------------------------|
|                                       |                                       |

TABLE Contact-2  AD Customer & Technical Support Contact Information (Continued)

<table>
<thead>
<tr>
<th>Standard Support:</th>
<th>Monday through Friday, 5:00 AM – 6:00 PM (MST), except corporate holidays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice:</td>
<td>801.377.5410, option 5</td>
</tr>
<tr>
<td>Voice:</td>
<td>800.658.5199 (Toll-free North America)</td>
</tr>
<tr>
<td>Email:</td>
<td><a href="mailto:Support@AccessData.com">Support@AccessData.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After Hours Phone Support:</th>
<th>Monday through Friday 6:00 PM to 1:00 AM (MST), except corporate holidays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice:</td>
<td>801.377.5410, option 5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After Hours Email-only Support:</th>
<th>Monday through Friday 1:00 AM to 5:00 AM (MST), except corporate holidays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email:</td>
<td><a href="mailto:afterhours@accessdata.com">afterhours@accessdata.com</a></td>
</tr>
</tbody>
</table>

International Support Europe/Middle East/Africa

<table>
<thead>
<tr>
<th>Standard Support:</th>
<th>Monday through Friday, 8:00 AM – 5:00 PM (UK-London), except corporate holidays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice:</td>
<td>+44 207 160 2017 (United Kingdom)</td>
</tr>
<tr>
<td>Email:</td>
<td><a href="mailto:emeasupport@accessdata.com">emeasupport@accessdata.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After Hours Support:</th>
<th>Monday through Friday, 5:00 PM to 1:00 AM (UK/London), except corporate holidays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice:</td>
<td>801.377.5410 Option 5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After Hours Email-only Support:</th>
<th>Monday through Friday, 1:00 AM to 5:00 AM (UK/London), except corporate holidays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email:</td>
<td><a href="mailto:afterhours@accessdata.com">afterhours@accessdata.com</a></td>
</tr>
</tbody>
</table>

Other

|-----------|----------------------------------|

The Support web site allows access to Discussion Forums, Downloads, Previous Releases, our Knowledgebase, a way to submit and track your “trouble tickets”, and in-depth contact information.

Note: All support inquiries are typically responded to within one business day. If there is an urgent need for support, contact AccessData by phone during normal business hours.

**DOCUMENTATION**

Please email AccessData regarding any typos, inaccuracies, or other problems you find with the documentation:

documentation@accessdata.com

**PROFESSIONAL SERVICES**

The AccessData Professional Services staff comes with a varied and extensive background in digital investigations including law enforcement, counter-intelligence, and corporate security. Their collective experience in working with both government and commercial entities, as well as in providing expert testimony, enables them to provide a full range of computer forensic and eDiscovery services.

At this time, Professional Services provides support for sales, installation, training, and utilization of FTK, Enterprise, eDiscovery, Lab, and Lab Lite. They can help you resolve any questions or problems you may have regarding these products.
Contact Information for Professional Services

Contact AccessData Professional Services in the following ways:

<table>
<thead>
<tr>
<th>Contact Method</th>
<th>Number or Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>Washington DC: 410.703.9237</td>
</tr>
<tr>
<td></td>
<td>North America: 801.377.5410</td>
</tr>
<tr>
<td></td>
<td>North America Toll Free: 800-489-5199, option 7</td>
</tr>
<tr>
<td></td>
<td>International: +1.801.377.5410</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:adservices@accessdata.com">adservices@accessdata.com</a></td>
</tr>
</tbody>
</table>
## Table of Contents

**AccessData Legal and Contact Information** ................................................................. i
  - Legal Information ........................................................................................................ i
  - AccessData Trademarks ............................................................................................... i
  - Copyright Information ................................................................................................ ii
    - AFF® and AFFLIB® ..................................................................................................... ii
    - Ayende Rahien .......................................................................................................... ii
  - Documentation Conventions ......................................................................................... iii
  - Registration .................................................................................................................. iii
    - Subscriptions ........................................................................................................... iii
  - AccessData Contact Information ................................................................................ iv
    - Mailing Address and General Phone Numbers ....................................................... iv
    - Technical Support ..................................................................................................... iv
    - Documentation .......................................................................................................... v
  - Professional Services .................................................................................................... v
    - Contact Information for Professional Services ...................................................... vi

**Table of Contents** .......................................................................................................... vii

**Chapter 1 Introduction** ................................................................................................... 1
  - Audience ...................................................................................................................... 1
  - Forensic Cases and Evidence Handling ...................................................................... 1

**Chapter 2 MPE+ Installation** .......................................................................................... 2
  - Prerequisites ................................................................................................................ 2
    - Hardware and Software Requirements ..................................................................... 2
  - Installing MPE+ ............................................................................................................ 3
    - Installing Mobile Device Drivers ............................................................................ 7
    - Installing Physical Acquisition Support Files ................................................. 9
    - Installing Language Selector ................................................................................. 9

**Chapter 3 Getting Started** ............................................................................................. 11
  - Licensing ...................................................................................................................... 11
    - About Licensing ...................................................................................................... 11
Chapter 4 User Interface

About the Tasks Menu
About the Toolbar
Performing Tasks in MPE+
  Selecting a Device
  Connecting a BlackBerry Device to MPE+
  Acquiring Physical Apple Device Images
  Acquiring Apple Device Partitions
Extracting Data
Carving Data
Importing an AD1 Image
Exporting To an AD1 Image
Using Quick Print for MPE+ Reports
Managing Settings
About Help Menu
About Review Panes
  Data Type Tabs
  Phonebook
  Messages
  MMS
  Call History
  Calendar Data
  Media Files
  File System
About Status Bars
  Phone Data Bar
  Status Bar

Appendix A Managing Security Devices and Licenses

AccessData Product Licenses
Installing and Managing Security Devices
Installing LicenseManager
Starting LicenseManager
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using LicenseManager</td>
<td>50</td>
</tr>
<tr>
<td>Updating Products</td>
<td>57</td>
</tr>
<tr>
<td>Sending a Dongle Packet File to Support</td>
<td>58</td>
</tr>
<tr>
<td>Virtual CodeMeter Activation Guide</td>
<td>58</td>
</tr>
<tr>
<td>Introduction</td>
<td>58</td>
</tr>
<tr>
<td>Preparation</td>
<td>59</td>
</tr>
<tr>
<td>Setup for Online Systems</td>
<td>59</td>
</tr>
<tr>
<td>Setting up VCM for Offline Systems</td>
<td>60</td>
</tr>
<tr>
<td>Creating a Virtual CM-Stick with Server 2003/2008 Enterprise Editions</td>
<td>62</td>
</tr>
<tr>
<td>Additional Instructions for AD LAB WebUI and eDiscovery</td>
<td>63</td>
</tr>
<tr>
<td>Virtual CodeMeter FAQs</td>
<td>64</td>
</tr>
<tr>
<td>Network License Server (NLS) Setup Guide</td>
<td>66</td>
</tr>
<tr>
<td>Introduction</td>
<td>66</td>
</tr>
<tr>
<td>Preparation Notes</td>
<td>66</td>
</tr>
<tr>
<td>Setup Overview</td>
<td>66</td>
</tr>
<tr>
<td>Network Dongle Notes</td>
<td>67</td>
</tr>
<tr>
<td>NLS Server System Notes</td>
<td>67</td>
</tr>
<tr>
<td>NLS Client System Notes</td>
<td>67</td>
</tr>
</tbody>
</table>
Chapter 1 Introduction

The AccessData (AD) Mobile Phone Examiner Plus (MPE+) is a powerful mobile device data review tool that can be used in the field as part of a mobile field unit or in the lab. Additionally, data extracted from mobile devices using MPE+ can be easily imported into an FTK case which offers more in-depth drill-down, categorization, full-text index searching, and all of this right along side other digital evidence collected for a case. MPE+ can extract information such as phone and address book data, media files, call logs, SMS and MMS messages, calendar, and file system data stored in the memory of a mobile device.

Audience

MPE+ and its manual are written for law enforcement and corporate security professionals with the following competencies:

- Basic knowledge of and training in forensic policies and procedures.
- Basic knowledge of and experience with personal computers, mobile phones, enhanced PDAs, and SmartPhones.
- Familiarity with the fundamentals of collecting digital evidence from mobile devices.
- Understanding of forensic data images and how to acquire forensically sound images.
- Experience with case studies and reports.
- Basic competency with FTK.
- Familiarity with the Microsoft Windows environment.

Forensic Cases and Evidence Handling

For information on how to handle the image as evidence in a case, see the FTK User Guide.
CHAPTER 2 MPE+ INSTALLATION

PREREQUISITES

To install AccessData FTK MPE+, you must have the following:
- A current AccessData MPE+ license.
- An updated GSM license. All MPE customers who are current on their MPE license automatically have updated licenses. Owners of MPE licenses that expired November 2010 or earlier, should contact support prior to upgrading to MPE 4.1.
- The AccessData WIBU-SYSTEMS CodeMeter Runtime, version 4.10a or later, installed on the computer where MPE+ will be run.
- An AccessData WIBU-SYSTEMS CodeMeter Virtual or USB license device connected to the computer where MPE+ will be run.
- Microsoft .Net 4.0 must be installed on the computer where MPE+ will be installed.

To use MPE+ images with FTK
1. Install FTK 3.x either before or after installing MPE+.
2. Ensure that CodeMeter Runtime is installed.
3. Open FTK and create an Application Administrator.
4. Ensure the Case Manager window can open.
5. Exit FTK.

HARDWARE AND SOFTWARE REQUIREMENTS

Before using MPE+ to image and use phone images as part of an investigation, certain hardware and software requirements must be met.

SOFTWARE AND LICENSE REQUIREMENTS

To run MPE+, in addition to the hardware requirements, you need the following:
- An additional license with separate installation.
- MPE+ operates as a standalone product on the Microsoft Windows OS platform.
- AccessData FTK must be installed if you intend to add the imaged phone data to a case for further investigation.

Images created by MPE+ are AccessData-proprietary AD1-type images. MPE+ images can be imported back into MPE+, and can be added as evidence to a case in any AD FTK-core product. MPE+ requires third-party drivers to read the information on the phone and make it into a forensic image. This is further explained in “Chapter 2 MPE+ Installation” on page 2.
HARDWARE REQUIREMENTS

MPE+ requires the following additional hardware:
- USB ports on your machine.
- WIBU-SYSTEMS CodeMeter USB or Virtual CmStick (with current licenses installed).
- An evidence phone with intact contents.
- A data synchronization cable specific to the mobile device. Several are shipped with MPE+. MPE+ also works with the Susteen brand cable set. For a list of mobile phones and the cable required to interface each phone with the investigating computer, click the Supported Devices button on the Toolbar. For more information, see “About the Toolbar” on page 17.

OPTIONAL HARDWARE

AccessData MPE+ can be purchased together with an optional portable imaging unit currently referred to as a “MPE+ Field Tablet.”

The MPE+ Field Tablet is shipped with the Microsoft Mobile OS installed. The Accelerometer feature is enabled. This may cause unwanted behavior in a list view when moving the Tablet. To normalize the behavior, disable the Accelerometer feature.

INSTALLING MPE+

An installation of MPE+ includes the following components:

- MPE+ Licensing
- MPE+ Application
  See “To install MPE+” on page 3.
- MPE+ Device Drivers Installer (Optional)
  See “Installing Mobile Device Drivers” on page 7.
- Apple Physical Acquisition Support Files (Optional)
  See “Installing Physical Acquisition Support Files” on page 9.
- Language Selector (Optional)
  See “Installing Language Selector” on page 9.

The MPE+ installer automatically configures MPE to run as an administrator. In order to function properly, MPE+ requires local administrator rights to the system, and therefore it must also be installed by a user with local administrator privileges.

Important: If you are upgrading from a previous version, you must follow the steps outlined under “Upgrading from a Previous Version” on page 6 in order for the application to function properly.

To install MPE+

1. Insert the MPE+ installation media into the CD/DVD drive. (If the autorun.exe does not launch automatically, explore the disk drive and run it manually.)
2. Click **MPE+ Install**

![MPE+ Install window](image)

3. Click **Next** to begin the installation.

![Welcome to the setup wizard](image)
4. Read the License Agreement, then click **Agree** to continue.

5. Select a destination folder and click **Next** to continue.
6. Click *Install* to begin the installation process.

   ![AccessData Mobile Phone Examiner Plus Setup](image1)

7. Click *Finish* to close the Wizard when installation is complete.

   ![AccessData Mobile Phone Examiner Plus Setup](image2)

**Upgrading from a Previous Version**

If you are upgrading from a previous version of MPE, follow these instructions, otherwise, steps 5 and 6 will suffice. If you need more information about installing, see “Installing MPE+” on page 3.

**To upgrade from a previous version of MPE**

1. Launch MPE (old version).
2. Deactivate your old GSM license (see “Deactivating a GSM License” on page 12 for more information on deactivating your license).
3. Exit MPE.
4. Uninstall old version(s) of MPE.
5. Install new version of MPE+. (For help, see “Installing MPE+” on page 3)
6. Activate using the new license key license when prompted (see “Activating a GSM License” on page 12 for information on how to activate your license).

**Installing Mobile Device Drivers**

Many of the device drives supported by MPE can be installed simply by running the AccessData Mobile Phone Examiner Driver installer.

**Important:** These steps should only be run for new installations. Do not run this installation if you already have your mobile device drivers installed.

**To install Mobile Device Drivers**

1. Insert the MPE+ installation media into the CD/DVD drive. (If the autorun.exe does not launch automatically, explore the disk drive and run it manually.)

2. Click **Install Drivers**.

3. Click **Next** to begin the installation.

4. Read the License Agreement, then click **Agree** to continue.

5. Select the device drivers you would like to install.

**Note:** Do not select drivers that are already installed to your system.
6. Click **Install** to begin the installation process.

   **Note:** Depending on your selection, the individual driver installers may prompt for user interaction in order to proceed.

7. Click **Finish** to close the Wizard when installation is complete.
**INSTALLING PHYSICAL ACQUISITION SUPPORT FILES**

After you have installed the MPE+ application, you will install additional files to enable Apple physical device acquisition functionality.

**Important:** No mobile device should be connected to the Tablet or the computer running MPE+ while running this installer.

**Note:** An active internet connection is required for this step.

**To download the Physical Acquisition Support Files**

1. Connect your license device to the system.
2. Launch MPE+.
   
   You will be prompted automatically to download these support files if MPE+ detects that the files are missing.

   **Note:** If you choose to skip this step, all other features will still function, but this prompt will appear each time you open MPE+ until you allow the files to download.

**FIGURE 2-1 Support Files Download Message Box**

3. Click Yes.
   
   The physical acquisition support files will be downloaded and installed.

**INSTALLING LANGUAGE SELECTOR**

To change to another supported language other than the default English (United States) that ships with MPE+, Language Selector must be installed.

**INSTALL LANGUAGE SELECTOR**

**To install Language Selector**

1. From the MPE+ install disc Autorun Main Menu, click *Install Other Products* and then click *Install Language Selector*.
   
   The Language Selector Installer runs.
2. Click Next to continue.
3. Read and accept the License Agreement. Click Next to continue.
4. Click Install.
5. Click Finish.
Using Language Selector

To run Language Selector

1. Do one of the following:
   - Click Start > All Programs > AccessData > Language Selector > Language Selector.
   - Click the Language Selector Icon on your desktop.

Language Selector has a very simple interface.

2. Click the Select Languages drop-down to select the language to use. Languages to choose from are as follows:

<table>
<thead>
<tr>
<th>Chinese (PRC)</th>
<th>English (United States)</th>
<th>Japanese</th>
</tr>
</thead>
<tbody>
<tr>
<td>German (Germany)</td>
<td></td>
<td>Portuguese (Brazil)</td>
</tr>
<tr>
<td>Korean</td>
<td></td>
<td>Swedish</td>
</tr>
<tr>
<td>Spanish (Traditional Sort)</td>
<td></td>
<td>Turkish</td>
</tr>
</tbody>
</table>

The “Products supporting this language” text box indicates the AccessData programs that will be affected by the language selection.

The File menu contains two choices:

- Select Language
- Exit

The Help menu contains one choice:

- About — Provides version and copyright information.

3. Click Save Settings to save selections and close Language Selector.
CHAPTER 3 GETTING STARTED

This chapter contains all the information you need to get started with MPE+, including licensing you software and connecting devices to your computer. Once you have completed the information covered in this chapter, MPE+ will be ready to extract and save data from devices.

LICENSING

ABOUT LICENSING

MPE+ requires two different licenses in order to function properly.
- MPE License: Required to launch the application.
- GSM License: Required to communicate with any GSM device.

MPE LICENSE OPTIONS

Choose among the following licensing options:

See “Appendix A Managing Security Devices and Licenses” on page 39 for more information on licensing.

Note: The MPE+ Field Tablet ships with a built in MPE license, and does not require an additional license.

GSM LICENSE

The GSM Licensing information includes the following items that came with your software:
- Activation Key
- User Name

Note: The Activation Key can be deactivated at any time see “Deactivating a GSM License” on page 12 for information on how to do this.
**Activating a GSM License**

**Activating on an Online Computer**

An “online” computer has an active Internet connection.

**To activate the GSM license on an online computer**

1. Launch MPE+.
2. If you have not entered your GSM provider license, it will prompt you to enter it. Type the Activation Key and User Name.
3. Click *Activate*.

If you have a failure during activation, you can follow the steps in “Activating on an Offline Computer” on page 12. The process for activating on an online computer is the same as with an offline computer except that you only do steps 1-7, 13, 15, and 16 of the offline activation.

**Activating on an Offline Computer**

An “offline” computer does not have an active or available Internet connection.

**To activate the GSM license on an offline computer**

- Refer to the Offline Activation guide located at:
  

**Deactivating a GSM License**

The deactivate function allows the license to be removed from one machine and placed on another.

**To deactivate the GSM license**

1. Click the *Settings* button.

2. In the Settings dialog, click *Deactivate*.

   The Activation Key and User Name deactivates and the *Deactivate* button becomes the *Activate* button.

   To reactive your software, enter the Activation Key and User Name that came with your software and click *Activate*. 
Connecting Devices

The process of connecting a device to the system for the purpose of examination is made up of two basic tasks, installing device drivers and establishing a data connection to the device.

Installing Device Drivers

Each supported mobile device that you plan to examine must have the correct driver installed before the device is connected. For any device to be detected by MPE+, the manufacturer’s device driver must first be properly installed.

Mobile device drivers can be found on the MPE+ installation disk as well as in the ZIP archive of the MPE+ download.

Note: AccessData recommends using Windows XP or Windows 7 systems for use with MPE+. You may encounter driver issues when running MPE+ on Vista.

Note: Users of the MPE+ Field Tablet will find that many of the most common drivers have been pre-installed on their system.

To install a manufacturer device driver

1. Verify the device manufacturer and model is listed in the Supported Device list. View the list by clicking the Supported Devices button on the toolbar.
2. Locate the correct USB cable and connect the phone to the computer through the USB cable.
3. Upon connecting the device, Windows will automatically attempt to locate the appropriate driver. You will likely be prompted to provide the path to the appropriate driver; if so, browse to the path of the driver based on the name of the manufacturer found in the device drivers folder.
4. Once you have selected a driver, Windows will provide feedback as to whether or not the driver was successfully installed.
   If the selected driver fails to install, you may need to repeat the process starting from Step 1.
   If Windows indicates that the driver did install successfully, however, proceed to the next step.
5. Once the driver has been successfully installed, you may be prompted to locate additional drivers, this is normal and you should continue to repeat the process for as many drivers as Windows detects that it needs.
6. Verify the device is properly listed in the Windows Device Manager.

Note: Only currently connected devices will be listed in Windows Device Manager. Device drivers you have installed previously will not be listed unless the device is connected.

Establishing a Data Connection to a Mobile Device

Important: When acquiring both physical and logical data from Apple devices, you must follow this procedure before launching MPE+ and attaching any iOS device. Otherwise, COM issues can arise when iTunes takes over the port when the software launches.

Disable Auto Sync

1. Launch iTunes.
2. Select Preferences for the iTunes menu.
3. Click on the Devices tab.
4. Check Disable automatic syncing for iPhones and iPods.
To connect a mobile device for the first time

1. Power up the device (wait until the device is fully powered on before proceeding to the next step).

2. Plug in the device data cable.

3. Check Windows Device Manager to ensure that the device is being detected correctly.
   If the device is not listed in the Windows Device Manager, double check that the appropriate driver is properly installed. For more information, see “Installing Device Drivers” on page 13.

4. Once a Windows data connection has been established, you are now ready to select the device in MPE+. See “Selecting a Device” on page 18.

Note: If you are unable to connect your device, follow the steps in “Resetting a Mobile Device Connection” on page 14.

Resetting a Mobile Device Connection

If you’re going to process/connect a phone multiple times, power cycle the phone (remove the battery) between each connection.

To connect a mobile device

1. Exit the MPE+ application.

2. Unplug the device data cable.

3. Remove the battery cover on the device.

4. Remove the battery from the device.

5. Remove the SIM card (if applicable).

6. Properly clean all battery and SIM card contacts.

7. Reassemble the device.

8. Power up the device (wait until the device is fully powered on before proceeding to the next step).

9. Plug in the device data cable.

10. Check Windows Device Manager to ensure that the device is being detected correctly.
    If the device is not listed in the Windows Device Manager, double check that the appropriate driver is properly installed. For more information, see “Installing Device Drivers” on page 13.

11. Launch MPE+.

12. Once a Windows data connection has been established, you are now ready to select the device in MPE+. See “Selecting a Device” on page 18.

Verifying User Data from Mobile Devices

It is important to be able to verify the accuracy and consistency of data when comparing the original to the acquired copy.

To verify user data from a mobile device

1. Make an image of the file system.

2. Add it as evidence into FTK.

3. Create a KFF of all the file hashes in the image.

4. Make another image of the file system (with another tool).

5. Compare the second image against that same KFF to see what files changed.
Some system files will have changed, but the user data should not.
CHAPTER 4 USER INTERFACE

This chapter will make you familiar with the graphical interface of MPE+. It will also walk you through how to select a device in MPE+, how to extract data from a device, how to import data into MPE+, and how to extract data from MPE+ into an AD1 file.

ABOUT THE TASKS MENU

Use the Tasks menu to select from the options described in the table below. Click on the cross reference in each description to see more detailed information about how to use each of these features and options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Device</td>
<td>Click Select Device to open the Device Selection dialog. See “Selecting a Device” on page 18 for more information.</td>
</tr>
<tr>
<td>Extract Data</td>
<td>Click Extract Data when the correct drivers are installed and the device is connected and has been recognized and selected, to extract selected data from the phone or other mobile device. The extracted data can be viewed using the tabs on the Navigation Bar on the left side of the MPE+ main window. See “Extracting Data” on page 25 for more information.</td>
</tr>
<tr>
<td>Data Carve</td>
<td>Click Data Carve to find data that may have been deleted from the phone but that has not been overwritten. The Data Carve Options box allows you to select which data types to carve if they are found. See “Carving Data” on page 27 for more information.</td>
</tr>
<tr>
<td>Import from AD1</td>
<td>Click Import AD1 on the toolbar if the mobile device is no longer available, but you have created an image of the device using MPE+, and you want to view the device’s data. See “Importing an AD1 Image” on page 30 for details.</td>
</tr>
<tr>
<td>Export to AD1</td>
<td>Click Export to AD1 Format to export the extracted data to an AD1 custom content image that can be added to a case in FTK, or imported back into MPE+ later, without the device connected, to view the extracted data. See “Exporting To an AD1 Image” on page 30 for more information.</td>
</tr>
<tr>
<td>Quick Print</td>
<td>Click Quick Print Report to open the Quick Print Report dialog box. This allows you to select the data types to Preview, Export, or Print. See “Using Quick Print for MPE+ Reports” on page 30 for details.</td>
</tr>
<tr>
<td>Settings</td>
<td>Click Settings to see GSM Activation and License Source information. See “Using Quick Print for MPE+ Reports” on page 30.</td>
</tr>
<tr>
<td>Exit</td>
<td>Click Exit to close Mobile Phone Examiner Plus.</td>
</tr>
</tbody>
</table>
ABOUT THE TOOLBAR

The toolbar has many buttons to choose from. Each is listed and described in the following table. Notice that of these buttons, some are also found in the Tasks menu.

Click on the cross reference in each description in the table below to see more detailed information about how to use each of these features and options.

**TABLE 4-2 MPE+ Toolbar Buttons**

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select Device" /></td>
<td>Click the Select Device button to open the Device Selection dialog. See “Selecting a Device” on page 18 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Extract Data" /></td>
<td>Click the Extract Data button when the correct drivers are installed and the device is connected and has been recognized and selected, to extract selected data from the phone or other mobile device. The extracted data can be viewed using the tabs on the Navigation Bar on the left side of the MPE+ main window. See “Extracting Data” on page 25 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Data Carve" /></td>
<td>Click the Data Carve button to find data that may have been deleted from the phone but that has not been overwritten. The Data Carve Options box allows you to select which data types to carve if they are found. See “Carving Data” on page 27 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="AD1 Export" /></td>
<td>Click the AD1 Export button to export the extracted data to an AD1 custom content image that can be added to a case in FTK, or imported back into MPE+ later, without the device connected, to view the extracted data. See “Exporting To an AD1 Image” on page 30 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Import AD1" /></td>
<td>Click the Import AD1 button on the toolbar if the mobile device is no longer available, but you have created an image of the device using MPE+, and you want to view the device’s data. See “Importing an AD1 Image” on page 30 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Quick Print Report" /></td>
<td>Click the Quick Print Report button on the toolbar to open the Quick Print Report dialog box. This allows you to select the data types to Preview, Export, or Print. See “Using Quick Print for MPE+ Reports” on page 30 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Display Current Device Info" /></td>
<td>Click the Display Current Device Info button on the toolbar to view basic information about the device that is currently connected to MPE+. This information includes the IMEI, Phone Number, Comments, Model, Manufacturer, Serial Number, and Revision.</td>
</tr>
<tr>
<td><img src="image" alt="Supported Devices" /></td>
<td>Click the Supported Devices button to see the full list of MPE+ Supported Devices. The Supported Mobile Devices List can be exported from the list view. New beginning in version 4.1, supported devices include certain Apple and BlackBerry devices.</td>
</tr>
<tr>
<td><img src="image" alt="Settings" /></td>
<td>Click Settings to see GSM Activation and License Source information. See “Using Quick Print for MPE+ Reports” on page 30.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Click Help to see the User Guide or information about your product.</td>
</tr>
</tbody>
</table>
PERFORMING TASKS IN MPE+

This section provides more detailed information regarding the use of MPE+ features.

SELECTING A DEVICE

When MPE+ is run, the Device Selection dialog box opens automatically. If you have closed this dialog box and you want to select a device, you can easily do so.

To select a device

1. From the Tasks menu, click Select Device.
2. From the Device Selection dialog box, click Identify.
   - If you click Identify and a message displays stating that the program was “Not able to identify” the device, click OK, then click Identify again.
3. When the Device Identify text box is populated, click the Manufacturer dropdown and select the Manufacturer name of the connected device as identified in the Device Identify dialog box.
4. Click the Model drop-down and select the Model of the connected device as identified in the Device Identify dialog box.
5. Select the correct port as follows:
   - For CDMA: Click the COM Port dropdown to select the Serial port.
   - FOR GSM: Click Refresh Port(s). The program automatically selects the correct port. AccessData recommends that you DO NOT click the dropdown or try to change the automatically selected port when using a GSM device.
   - Note: Remember that generally the Modem Port is used to identify the device; the Serial Port is used to acquire & extract data.
6. Click Connect.

Use the following figure and table to understand the options in the Device Selection dialog.
IDENTIFYING A DEVICE

If the device is already connected, and the drivers are correctly installed, the Identify button is active in the Device Selection dialog. Click the Identify button to populate the Device Identify group box. This group box gives you the details that you need to add the Manufacturer and Model dropdown information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>Select the manufacturer of the connected device. You can find the manufacturer underneath the battery of the device or by clicking the Identify button.</td>
</tr>
<tr>
<td>Model</td>
<td>Select the model of the connected device. You can find the model underneath the battery of the device or by clicking the Identify button.</td>
</tr>
<tr>
<td>COM Port</td>
<td>Select the port that the device is connected to. Click the Advanced button to identify the correct port.</td>
</tr>
<tr>
<td>Cable #</td>
<td>Displays the cable number for the selected device after the manufacturer and model are selected. For more information on cables, see the Supported Devices list by clicking on Supported Devices on the Toolbar.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Click to open the Advanced Port Selection dialog. From here, you can see the ports available for use on the connected device.</td>
</tr>
<tr>
<td>Refresh Ports</td>
<td>Click to refresh the COM Port dropdown.</td>
</tr>
<tr>
<td>Identify</td>
<td>Click to populate the Device Identify group box.</td>
</tr>
<tr>
<td>Device Identify</td>
<td>Displays information about the connected device, including manufacturer and model. Populated by clicking the Identify button.</td>
</tr>
<tr>
<td>Reset</td>
<td>Removes all selected information from the Device Selection dialog.</td>
</tr>
<tr>
<td>Connect</td>
<td>Connects to the attached device. This button is only active after a manufacturer, model, and port are selected.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Device Selection dialog.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the status of the device selection process.</td>
</tr>
</tbody>
</table>
**Using the Advanced Dialog**

Click the Advanced button in the Device Selection dialog to open the Advanced Port Selection dialog. This dialog shows you the detailed port information you need to make the correct selection from the COM Port dropdown of the Device Selection dialog.

As stated earlier, in most cases, the Modem Port is used to identify the device; the Serial Port is used to acquire & extract data.

**Figure 4-2** Advanced Port Selection

---

**Connecting a BlackBerry Device to MPE+**

MPE+ 4.1.0 and later requires a specific procedure for acquiring data from certain BlackBerry devices. This section details that procedure.

The following table lists BlackBerry devices that are supported for logical capture only. Others may work, but are not officially supported.

**Table 4-4** MPE+ Supported BlackBerry Devices (Logical Capture Only)

<table>
<thead>
<tr>
<th>Supported BlackBerry Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>8120 Pearl</td>
</tr>
<tr>
<td>8520 Curve</td>
</tr>
<tr>
<td>9000 Bold</td>
</tr>
<tr>
<td>9530 Storm</td>
</tr>
</tbody>
</table>

To set up MPE with a supported BlackBerry device to extract data:

1. Install BlackBerry_USB_and_Modem_Drivers.msi from the MPE CD onto your computer.
   Shows up as BlackBerry Desktop Software 4.7 Power on the phone.
2. Connect the device using cable #1 (mini USB).
   Windows Device Manager should show RIM Virtual Serial Port v2 under Port.
3. In MPE, click the Select Device button (or Tasks > Select Device).
4. Select BlackBerry in the Manufacturer drop-down.
5. Select the correct device in the Model drop-down.
6. Click Refresh Port(s).
   The COM Port field should then say BlackBerry Smartphone.
7. Click Connect and follow the standard procedure to extract the data you want.

**Acquiring Physical Apple Device Images**

If you want to acquire Apple devices physically, you must ensure that your system is configured properly before proceeding. This section describes how to configure your system to acquire physical images of supported Apple devices.

**Prerequisites**

- Install the physical acquisition support files, see “Installing Physical Acquisition Support Files” on page 9.
- Apple iTunes (Automatically installed and configured by the AccessData Mobile Device Installer.)
  
  **Note:** If you have already installed iTunes, select the option to launch iTunes upon completion of install.
  - Disable iTunes autosync if enabled. See “Disabling Autosync” on page 21.
  - Uninstall Quicktime if installed.
- You may need up to 3 times the storage capacity of the device available on destination drive (or network storage).

**Disabling Autosync**

When acquiring both physical and logical data from Apple devices, you must follow this procedure before launching MPE+ and attaching any iOS device. Otherwise, COM issues can arise when iTunes takes over the port.

**To disable autosync**

1. Launch iTunes.
2. Select Preferences from the iTunes menu.
3. Click on the Devices tab.
4. Check Disable automatic syncing for iPhones and iPads.

**Connecting to an Apple Device for Physical Acquisition**

In order to acquire data from Apple devices you need to complete all the prerequisites (see “Prerequisites” on page 21).

**Important:** After the completion of DFU wizard, do not disconnect, power off, or press any buttons on the device.

**To acquire data from an Apple device**

1. Power on your Apple device and connect it to the MPE+ system via a USB cable. Your device should now be booted into normal mode.
2. Launch MPE+ and click the Select Device button.

3. In the Device Selection dialog, select Apple from the Manufacturer drop-down list, iDEVICE/ (Physical) as the Model, and then click Connect.

The DFU wizard launches.

**Note:** Power users may put the device in DFU mode prior to clicking the connect button which will bypass the DFU wizard and then skip to step 13.

4. Press and hold the sleep button (button on the top of device).

5. Slide the red button to power off.

6. Wait 10 seconds after device has powered off completely.

7. Click the Connect button.

8. After you click the Next button on this screen (shown above), you will have 3 seconds to get your hands into position over the buttons.
9. At that end of the 3 second “Get Ready” count-down, press and hold the Sleep and the Home buttons simultaneously. Hold both buttons down until the countdown reaches zero. This is the first step towards powering on the device into DFU mode.

Note: Press the Sleep button (top) before the Home button (bottom) if it is not possible to press both at the same time.

10. As the 10 seconds count down, get ready to release the Sleep button (top) while still holding the Home button (bottom). Release the button when prompted.

11. The wizard will automatically transition to the next slide and will begin a new countdown.

12. If successful, the wizard will say Complete!

Note: If you enter recovery mode, you must unplug the device, and boot the device back into normal mode by holding both buttons until you see the apple logo. Then, click the yellow Restart button to start the wizard over again. For help see “Troubleshooting Apple Driver Mode” on page 24.
13. At this point you should see the screen go all white, then all black (and on some devices an 
AccessData custom splash screen appears). Lastly, an Apple logo with an empty progress 
meter appears.

14. After the progress meter reaches 1% completion, MPE should prompt you to choose which 
partitions you would like to acquire from the device.

**Important:** From this point on, if you make any mistake, no cancel options will be provided. 
The only recourse will be to unplug the device, boot the device back into normal mode, and 
start the connect process again from the beginning.

### Acquiring Apple Device Partitions

Before you can proceed with these steps, you must be properly connected to the device. 
See “Connecting to an Apple Device for Physical Acquisition” on page 21.

1. When prompted to select which partitions you would like to acquire, choose one of the 
   following:
   - Full Disk (gets user partition, OS Partition, and slack space).
   - OS partition (usually quite small about 1GB).
   - User partition (Device storage capacity minus OS partition).
   - Decrypted user partition (Same size as user partition. This option will only be available for 
devices that support encrypted user partitions).

**Note:** During physical Apple device acquisition, once you have confirmed which partitions you 
wish to extract, you cannot cancel the “Browse for folder” dialog in order to change the 
selected partitions. At that point, clicking the cancel button will automatically save the 
extracted image to your desktop.

2. When prompted, browse to the desired destination to save the device image.

3. When the acquisition is complete, you will receive a message indicating that the process 
   completed successfully.

### Troubleshooting Apple Driver Mode

If you are unable to connect to an Apple device, it may be because the 
AppleMobileDeviceDriver.exe process is hanging. For help use the steps to confirm driver mode 
below.

The Apple driver has two modes:
- Apple Mobile Device USB Driver
- Apple Recovery (DFU) USB Driver

**Note:** You need to put the device into the mode appropriate for the type of extraction you are 
trying to do (logical vs physical extraction).

**To confirm driver mode**

1. Open Device Manager.
2. Click the Scan for hardware changes button.
3. Look under Universal Serial Bus Controllers.
4. Right click on Apple Mobile Device USB Driver.
5. Click Properties.
6. Click on the Details tab.
7. Notice the Value being reported.
8. Verify that the Value matches the state of the device.
9. If not, manually end the process in Task Manager.

**Extracting Data**

Once MPE+ has successfully connected to a device, data can then be extracted for review.

**Important:** During the extraction of data from a device using the MPE+ 4.1 Tablet, devices with a high storage capacity (including any expansion cards) may cause the memory usage to spike, thus causing the extraction to slow significantly. It is recommended that you eject any expansion slot memory cards and image them using FTK Imager, or use MPE+ Desktop for devices with large capacity internal storage chips.

**Note:** QuickTime must be uninstalled in order to extract data on Apple Devices.

**To extract data from a device**

1. Connect the device to the computer using the appropriate cable.
   To see a list of supported devices and cables, click the Supported Devices button on the toolbar.
   For more information on connecting devices, see “Establishing a Data Connection to a Mobile Device” on page 13.
2. Access the Device Selection dialog using one of the following methods:
   - If you have not already selected a device, click Tasks > Select Device from the menu bar to open the Device Selection dialog.
   - If you have selected a device, click Tasks > Extract Data and skip to step 7.
   **Note:** The ACS card reader does not work with MPE+.
3. Click the Identify button. See “Device Selection Dialog” on page 19 for information on how to identify a device.
4. Using the information from the Device Identify group box, select the correct information for the connected device from the Manufacturer and Model drop-downs.
5. Using the information you found in the Advanced Port Selection dialog, select the correct port from the COM Port drop-down. See “Using the Advanced Dialog” on page 20.
6. Click Connect.
   **Note:** If you are unable to connect to the device, see “Resetting a Mobile Device Connection” on page 14 for more information.
7. In the Select Data for Extraction dialog, check the data types that you want to extract from the connected device and click Extract.

The files are extracted and the data is displayed in the main MPE+ window. Use the Data Type tabs to review the data. For more information on the how to review the data, see “Data Type Tabs” on page 33.

Note: Not all devices carry the same information, and not all device drivers will allow the extraction of all the data the device holds. The Select Data for Extraction dialog only gives you the options appropriate for the device and driver combination you have connected. If a data type is not supported on the device, you will not be able to select it in this dialog and it will not be activated in the main MPE+ window.

Note: You may receive an error message indicating that some information was not able to be extracted. This is due to restraints in the device or driver you selected. Click Ok to continue. All extracted data will appear in the MPE+ main window.

Note: The Apple progress bar on the device on which you are performing a physical extraction is misleading. Although the job may complete, the progress bar will not reflect the complete status, and stops around the 90% mark.
**Important:** Once you have selected a device and extracted the data, before selecting another device, you must export the data in order to save the information. Do not attempt to open a second MPE+ window to select another device, this will cause conflicts in the program.

**Note:** MPE+ does not extract the current state of some iPhone/iPad devices on subsequent logical extractions. If any of the content changes on the phone and you try to re-extract without restarting MPE+, that new content will not be extracted.

**Carving Data**

Using the data carving feature, you can choose to carve data from the device’s file system. This allows you to preview what will be seen when data carving the device’s MPE AD1 image in FTK.

The following data types can be carved:

<table>
<thead>
<tr>
<th>Images</th>
<th>Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>HTML</td>
</tr>
<tr>
<td>Video</td>
<td>Audio</td>
</tr>
<tr>
<td>3G2</td>
<td>MP3</td>
</tr>
<tr>
<td>3GP</td>
<td>AMR</td>
</tr>
<tr>
<td>MPEG</td>
<td>QCP</td>
</tr>
<tr>
<td>MPEG</td>
<td>MP4</td>
</tr>
</tbody>
</table>

Carved data is not saved as a separate part of the phone data. It is also not exported to an MPE AD1 image. Its only purpose is to provide a preview of what can be found in the phone when the exported MPEAD1 image is added and carved in FTK. Saving or exporting carved data to an MPE AD1 image would result in duplicate data when that image is added to a case.
After the image is added to FTK, the items identified by carving in MPE+ must be re-carved to be added to the case.

However, items carved in MPE+ can be immediately reported using the Quick Print function, saving a report of the carved items to a PDF file, or printed.

Once data is carved, it is not saved, and cannot be retained and appended with data from subsequent carving operations. Repeating the carving process discards the previously carved data and replaces it with newly carved data. Keep this in mind if you carve one type of data and then want to add to the list by carving other data types. To do so, on subsequent carve operations you must choose all the file types you want to see results for in a single carve.

To run Data Carve

1. Choose one of the following methods to carve data in MPE+:
   - In the MPE+ window, from the menu click *Tasks > Data Carve.*
   - On the toolbar, click the *Data Carve* button.
     
     If you have previously carved data you will see the following message:

     ![Previously Carved Data will be Discarded Warning](image)

2. Click *Yes* to continue.

3. In the *Data Carve Options* dialog, check the data types to carve.

   ![The Data Carve Options Dialog Box](image)

   **Note:** Selecting more item types to carve causes the carve to take longer. The carver looks for the file headers, not just the extension, so that media files that are embedded in other files, such as in MMS messages, will also be found. Carving data that is embedded in MMS files is the only way they can be viewed.

4. Click *OK* to begin.
The Data Carving progress dialog box appears.

5. When carving is complete, the Cancel button deactivates and the Close button activates; click Close.

6. In the MPE+ main window, in the Data Tabs on the left, click on the Data Carve tab to view the carved data.

The carved data list is displayed in the left viewing pane.

The selected file, if complete, is displayed in the right viewing pane, as seen below.

Note: The Natural tab is also available, however, carved HTML files are usually best viewed in the Hex Tab.
**Importing an AD1 Image**

You can import into MPE+ only those AD1 images that were created in Mobile Phone Examiner. This accommodates the need to revisit an image prior to adding it to an FTK case.

You do not need to have the original source device connected to import an MPE+ AD1 image that was previously exported. You can import an existing AD1 image you previously exported from AccessData Mobile Phone Examiner Plus:

The imported image data can be viewed in MPE+ using the buttons on the Navigation Bar on the left side of the screen.

**To import an existing MPE+ AD1 image into MPE+**

1. In MPE+, select *Tasks > Import AD1*.
2. Browse to the folder containing the AD1 file to import.
3. Select the file.
4. Click *Open*.

If any data types were not selected, or were not available during extraction, and thus were not added to the exported AD1 image, that data type will be inactive in the imported image.

**Exporting To an AD1 Image**

All extracted data is exported to an MPE+ AD1 Image. If you want to include only certain types of data, select only those types to extract from the device.

When you are satisfied that the contents of the mobile device is interesting or important to the related case, you are ready to create an AD1 image of the extracted data.

The resulting image can be read by MPE+, or any FTK-based product.

**Note:** FTK Imager is not FTK-based. In other words, it is a standalone product that does not use the FTK code-base, and thus it cannot read MPE+ AD1 images.

**To export the currently extracted mobile device data to an AD1 image**

1. Select *Tasks > Export to AD1*.
2. When prompted, enter a filename and select a destination folder for the image that will be created.
3. Click *Save*.
4. In the confirmation message box, click *OK*.

**Note:** In addition to the AD1 file, a text file is saved in the same location that you designated that contains a date and time stamp for the export. This information is for your records.

**Adding an MPE+ AD1 Image to a Case in FTK**

An MPE+ AD1 image is added as evidence in FTK the same way any other AD1 image is added. Simply select *Acquired Image(s)* as the Evidence Type. For more information, see the AccessData FTK User Guide.

**Using Quick Print for MPE+ Reports**

Use the Quick Print feature to view data by Data Type, and Preview, Export, or Print a report that contains the data type(s) you select. The Quick Print feature only pulls data that is stored in the cache, and thus does not include File System data. In addition, this option will be active only if cache data is available from device extraction or image import.
Supported data types include:
- Phonebook/Contacts
- SMS Messages
- Call History
- Calendar
- Media
- Carved Items

This feature provides the following benefits:
- Easy review of the data by external persons not involved in the extraction, who may be interviewing subjects involved in the investigation.
- Previewing of data for court purposes where the full report has not been completed.
- Any other purpose that requires the immediate review of the extracted data.

If you plan to print the Phonebook data, it is important to generate a Preview or an Export first. Phonebooks often have a schema that allows for hundreds of entries and all the entries will print, including the blank ones.

The Preview and Export features allow you to see which pages actually have meaningful data of any data type before you print a hard copy.

If you need to include all pages to maintain continuity for distribution, use the Export feature and distribute the PDF.

**To preview a report**

1. From the MPE+ main window, click *Tasks > Quick Print*.

   ![The Quick Print Report Dialog Box](image)

2. In the Quick Print Report dialog box, mark the Data Types to include in the report. Choose one, several, or all.

3. Click *Preview*.

   The Quick Print Report Preview file is generated in PDF format, and opened by default in Adobe Reader.

   Adobe Reader is included on the MPE+ installation disk.

**To export a report**

1. After creating the Report Preview, from the Quick Print Report dialog box, click *Browse* on the right side of the Export Path text box to navigate to and select a destination for the report file.

2. Mark the Data Types to include in this report.
3. Click Export.

The Quick Print Report PDF file is generated and saved in the specified location.

To print a report

1. After creating a Report Preview, from the Quick Print Report dialog box mark the Data Types to include in this report.
2. Click Print.
3. In the Print dialog box
   3a. Select the printer to send the Quick Print Report PDF output file to.
   3b. If you have previewed the report, you may have identified specific pages to print or not print. Select the page range accordingly.
   3c. Specify the number of copies to print.
   3d. Click Print.

**MANAGING SETTINGS**

The Settings button on the toolbar opens the Settings dialog, which shows you your Activation Key, User Name, License Host, and License Port.

On the GSM License tab, you can view the Activation Key and User Name that you used when you activated your software. You can deactivate your license from this dialog if you want to reactivate your software with a different key or user name.

![Settings: GSM License tab](image)

The MPE License tab displays the License Host that is providing the GSM Activation information (this can be either localhost, or the computer name or IP Address of a remote network computer), and the License Port (the port number being used for transmitting activation information). The default port is 6921, but if this is in use, you can change it.

![Settings: MPE License tab](image)
ABOUT HELP MENU

Use the Help menu to select from the following options:

- **Supported Devices**: Click Help > Supported Devices, or the Supported Devices button on the Toolbar for more information.
- **User Guide**: Displays this User Guide.
- **About**: Displays information about your software including the version number.

ABOUT REVIEW PANES

DATA TYPE TABS

Use the tabs in the Data Type tabs on the Navigation Bar on the left side of the main window to browse the available mobile device data. The following table describes the buttons in the Data Type tabs.

<table>
<thead>
<tr>
<th>TABLE 4-6 Navigation Bar Data Type Tabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Phonebook button] Click the <strong>Phonebook</strong> button to view the phone book that was extracted or imported.</td>
</tr>
<tr>
<td>![Call History button] Click the <strong>Call History</strong> button to view the call history that was extracted or imported.</td>
</tr>
<tr>
<td>![Calendar button] Click the <strong>Calendar</strong> button to view the calendar that was extracted or imported.</td>
</tr>
<tr>
<td>![Media button] Click the <strong>Media</strong> button to view all the media, including pictures, video, sound, etc. that was extracted or imported.</td>
</tr>
<tr>
<td>![File System button] Click the <strong>File System</strong> button to view the file tree and files that were extracted or imported.</td>
</tr>
<tr>
<td>![Messages button] Click the <strong>Messages</strong> button to view texts that were extracted or imported.</td>
</tr>
<tr>
<td>![MMS button] Click the <strong>MMS</strong> button to view multi-media texts that were extracted or imported.</td>
</tr>
</tbody>
</table>

The buttons in the Data Types tabs are only activated if the device from which the information was extracted had the capability.
**Phonebook**

The Phonebook data lists the information it finds according to the driver capabilities. The figure below shows only name information for each Phonebook entry because the user did not add any more in-depth information than that.

**Figure 4-12 MPE+ Phonebook Data View**

**Messages**

The Messages data view provides information such as those listed in the following table.

Note: Messages with an asterisks next to them may have been corrupted when imported into MPE. The text of the message may not appear as it did on the phone.

**Table 4-7 Potential Device Message Data**

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Date Received</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Number of Originating Message</td>
<td>Phone Number of Recipient</td>
</tr>
<tr>
<td>Subject</td>
<td>Message Text</td>
</tr>
<tr>
<td>Priority</td>
<td></td>
</tr>
</tbody>
</table>
MMS files are text messages that include media.

**Note:** MPE+ does not currently extract MMS messages from CDMA phones. If you have a device that contains media text messages, but the MMS option is not available, it is because that device does not allow export of those files.
CALL HISTORY

The Call History tab displays the incoming, outgoing, and missed calls recorded in the device. The figure below shows an example of a call history log.

**FIGURE 4-15** MPE+ Call History Data View

<table>
<thead>
<tr>
<th>Type</th>
<th>Date</th>
<th>Name</th>
<th>Number</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missed</td>
<td>11/22/2007 1:12 PM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 1:13 PM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 2:29 PM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/20/2007 2:57 PM</td>
<td>Katherine</td>
<td>4305021503</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 10:52 AM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 9:35 AM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 9:50 AM</td>
<td>Demi Y</td>
<td>0012520149</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/12/2007 5:11 PM</td>
<td>Josh</td>
<td>00760047</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 1:10 PM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 1:20 PM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
<tr>
<td>Incoming</td>
<td>11/24/2007 6:12 PM</td>
<td>Amy</td>
<td>0019072927</td>
<td>00:00</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/24/2007 6:30 PM</td>
<td>Rich UH</td>
<td>0012524660</td>
<td>00:20</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/23/2007 5:59 PM</td>
<td>Amy</td>
<td>0016000601</td>
<td>00:14</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/24/2007 11:59 AM</td>
<td>Amy</td>
<td>2038592856</td>
<td>00:06</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/19/2007 2:47 PM</td>
<td>Amy</td>
<td>0013427840</td>
<td>00:14</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/19/2007 4:39 PM</td>
<td>Amy</td>
<td>0025039408</td>
<td>00:19</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/19/2007 10:38 AM</td>
<td>Amy</td>
<td>0123702457</td>
<td>00:19</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/19/2007 20:20 PM</td>
<td>Amy</td>
<td>0760047</td>
<td>00:05</td>
</tr>
<tr>
<td>Incoming</td>
<td>11/19/2007 7:55 AM</td>
<td>Amy</td>
<td>0712296922</td>
<td>00:05</td>
</tr>
<tr>
<td>Missed</td>
<td>11/24/2007 9:32 AM</td>
<td>Amy</td>
<td>0019072927</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/23/2007 5:54 PM</td>
<td>Lisa</td>
<td>0016070024</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 10:12 PM</td>
<td>Amy</td>
<td>0019072927</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/24/2007 4:09 PM</td>
<td>Amy</td>
<td>0019072927</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/24/2007 7:13 PM</td>
<td>Amy</td>
<td>0018023353</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>12/24/2007 12:27 PM</td>
<td>Amy</td>
<td>0012393029</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>12/24/2007 11:55 AM</td>
<td>Amy</td>
<td>2038592563</td>
<td></td>
</tr>
<tr>
<td>Missed</td>
<td>11/22/2007 10:10 PM</td>
<td>Amy</td>
<td>0016000601</td>
<td></td>
</tr>
</tbody>
</table>

CALENDAR DATA

The Calendar tab displays the items found in the device’s calendar, including start and end times, descriptions, locations, priority, alarms, notes, etc. The figure below shows an example of extracted calendar data.

**Important:** MPE has no way of knowing if the time stamp was stored on the phone as the local time or UTC.

**FIGURE 4-16** MPE+ Calendar Data View
**MEDIA FILES**

The Media tab contains media found on the device, including image files, video files, and sound files. Sound and video files can be played back within the MPE+ interface. The figures below show examples of extracted mobile device media files.

**FIGURE 4-17** MPE+ Media / Images Data View

**FIGURE 4-18** MPE+ Media / Sounds Data View Showing Embedded Media Player

**FILE SYSTEM**

The File System tab displays a recreation of the device's file system based on logical file system records extracted from the device. In this pane the examiner is able to drill-down into the file system and view the extracted data using either the Hex view, or the natural view.
Additionally, the examiner can click the “Find...” button (or use CTRL+F) to search for either text or hex string within the extracted data. The figure below shows an example of an extracted mobile device file system.

**FIGURE 4-19** MPE+ File System Data View

### ABOUT STATUS BARS

#### PHONE DATA BAR

The Phone Data bar is below the toolbar. It shows the following information:
- **Phone**: The name of the currently connected and recognized device.
- **Port**: The port number on which the currently connected device is configured to communicate.

**FIGURE 4-20** Phone Data Bar

<table>
<thead>
<tr>
<th>Phone</th>
<th>LG-VX5200</th>
<th>Port</th>
<th>LGE CDMA USB Serial Port (COM5)</th>
</tr>
</thead>
</table>

#### STATUS BAR

The Status Bar is at the bottom of the main window. Use the Status Bar to see the status of the current command activity for the device.

**FIGURE 4-21** The Status Bar
APPENDIX A MANAGING SECURITY DEVICES AND LICENSES

This chapter expands on the licensing information needed to run AccessData products, including AccessData product licenses, Virtual CodeMeter activation, and Network License Server configurations.

ACCESSDATA PRODUCT LICENSES

This section acquaints you with the managing AccessData product licenses. Here you will find details regarding the LicenseManager interface and how to manage licenses and update products using LicenseManager.

INSTALLING AND MANAGING SECURITY DEVICES

Before you can manage licenses with LicenseManager, you must install the proper security device software and/or drivers. This section explains installing and using the Wibu CodeMeter Runtime software and USB CmStick, as well as the Keylok USB dongle drivers and dongle device.

INSTALLING THE SECURITY DEVICE

As discussed previously, AccessData products require a licensing security device that communicates with the program to verify the existence of a current license. The device can be the older Keylok dongle, or the newer WIBU-SYSTEMS (Wibu) CodeMeter (CmStick). Both are USB devices, and both require specific software to be installed prior to connecting the devices and running your AccessData products. You will need:

- The WIBU-SYSTEMS CodeMeter Runtime software with a WIBU-SYSTEMS CodeMeter (CmStick), either the physical USB device, or the Virtual device. See

- The WIBU-SYSTEMS CodeMeter Runtime software, and the AccessData Dongle Drivers with a Keylok dongle

**Note:** Without a license security device and its related software, you can run PRTK or DNA in Demo mode only.

The CmStick or dongle should be stored in a secure location when not in use.

You can install your AccessData product and the CodeMeter software from the shipping CD or from downloadable files available on the AccessData website at [www.accessdata.com](http://www.accessdata.com).

Click Support > Downloads, and browse to the product to download. Click the download link and save the file locally prior to running the installation files.
INSTALLING THE CODEMETER RUNTIME SOFTWARE

When you purchase the full PRTK package, AccessData provides a USB CmStick with the product package. The green Keylok dongles are no longer provided, but can be purchased separately through your AccessData Sales Representative.

To use the CmStick, you must first install the CodeMeter Runtime software, either from the shipping CD, or from the setup file downloaded from the AccessData Web site.

LOCATING THE SETUP FILE

To install the CodeMeter Runtime software from the CD, you can browse to the setup file, or select it from the Autorun menu.

To download the CodeMeter Runtime software

1. Go to [www.accessdata.com](http://www.accessdata.com) and do the following:
2. Click **Support > Downloads**.
3. Find one of the following, according to your system:
   - CodeMeter Runtime 4.20b (32 bit)
     MD5: 2e658fd67df9da589430920624099b3
     (MD5 hash applies only to this version)
   - CodeMeter Runtime 4.20b (64 bit)
     MD5: b54031002a1ae18ada3cb91de7c2ee84
     (MD5 hash applies only to this version)
   - Click the **Download** link.
   - Save the file to your PC and run after the download is complete.

To run the CodeMeter Runtime Setup

1. Double-click the **CodeMeterRuntime[32 or 64]_4.20b.exe**.
2. In the Welcome dialog, click **Next**.

FIGURE A-1  CodeMeter Runtime Setup: Welcome
3. Read and accept the License Agreement

**FIGURE A-2** CodeMeter Runtime Setup: License Agreement.

4. Click **Next**.

5. Enter User Information.

**FIGURE A-3** CodeMeter Runtime Setup: User Information

6. Specify whether this application should be available only when you log in, or for anyone who uses this computer.
7. Click Next.

**FIGURE A-4** CodeMeter Runtime Setup: Select Features

8. Select the features you want to install.

9. Click Disk Cost to see how much space the installation of CodeMeter software takes, and drive space available. This helps you determine the destination drive.

**FIGURE A-5** CodeMeter Runtime Setup: Disk Cost

10. Click OK.

11. Click Next.

**FIGURE A-6** CodeMeter Runtime Setup: Ready to Install
12. When you are satisfied with the options you have selected, click Next.

**FIGURE A-7** CodeMeter Runtime Setup: Successfully Installed

13. Installation will run its course. When complete, you will see the “CodeMeter Runtime Kit v4.20b has been successfully installed” screen. Click Finish to exit the installation.

**THE CODEMETER CONTROL CENTER**

When the CodeMeter Runtime installation is complete, the CodeMeter Control Center pops up. This is a great time to connect the CmStick and verify that the device is recognized and is Enabled. Once verified, you can close the control center and run your AccessData product(s).

When the software is installed, but the CmStick is not connected, you will see a system tray icon that looks like this:

![System Tray Icon]

When the software is installed, and the CmStick is connected and recognized, you will see a system tray icon that looks like this:

![System Tray Icon]

For the most part there is nothing you need to do with this control center, and you need make no changes using this tool with very few exceptions. If you have problems with your CmStick, contact AccessData Support and an agent will walk you through any troubleshooting steps that may need to be performed.

**INSTALLING KEYLOK DONGLE DRIVERS**

**To install the Keylok USB dongle drivers**

1. Choose one of the following methods:
   - If installing from CD, insert the CD into the CD-ROM drive and click Install the Dongle Drivers.
     - If auto-run is not enabled, select Start > Run. Browse to the CD-ROM drive and select Autorun.exe.
If installing from a file downloaded from the AccessData Web site, locate the `Dongle_driver_1.6.exe` setup file, and double-click it.

**FIGURE A-8** Dongle Driver Setup

1. Click Next.

**FIGURE A-9** Dongle Driver Setup: Choose Setup Type for Dongle

3. Select the type of dongle to install the drivers for.
4. Click Next.

**FIGURE A-10** Dongle Driver Setup: Ensure USB Device is not Plugged In

5. If you have a USB dongle, verify that it is not connected.
6. Click OK.
A message box appears telling you that the installation is progressing.

**FIGURE A-11** Setup Progress Message Box.

7. When you see the Dongle Driver Setup window that says, “Finished Dongle Installation,” click *Finish*.

**FIGURE A-12** Dongle Driver Setup: Finished

8. Connect the USB dongle. Wait for the Windows Found New Hardware wizard, and follow the prompts.

**Important:** If the Windows Found New Hardware wizard appears, complete the wizard. Do not close without completing, or the dongle driver will not be installed.

**WINDOWS FOUND NEW HARDWARE WIZARD**

When you connect the dongle after installing the dongle drivers, you should wait for the Windows Found New Hardware Wizard to open. It is not uncommon for users to disregard this wizard, and then find that the dongle is not recognized and their AccessData software will not run.
To configure the dongle using the Found New Hardware Wizard

1. When prompted whether to connect to Windows Update to search for software, choose, “No, not this time.”

**FIGURE A-13** Found New Hardware Wizard: Welcome

2. Click Next.

3. When prompted whether to install the software automatically or to install from a list of specific locations, choose, “Install the software automatically (Recommended).”

**FIGURE A-14** Found New Hardware Wizard: Install Automatically

4. Click Next.
5. Click *Finish* to close the wizard.

**FIGURE A-15** Found New Hardware Wizard: Complete

Once you have installed the dongle drivers and connected the dongle and verified that Windows recognizes it, you can use LicenseManager to manage product licenses.

**INSTALLING LICENSEMANAGER**

LicenseManager lets you manage product and license subscriptions using a security device or device packet file.

To download the LicenseManager installer from the AccessData web site

1. Go to the AccessData download page at:
2. On the download page, click the *LicenseManager Download* link.
3. Save the installation file to your download directory or other temporary directory on your drive.
   3a. The current version information is as follows:
   - License Manager version 3.1.1 (*LicenseManager_3.1.1.exe*)
   - Release Date: March 25, 2010
   - MD5: 2e645ca8b0ca57aafbc156213be2147f (for this version only)

To install LicenseManager

1. Navigate to, and double-click the installation file.
2. Wait for the *Preparing to Install* processes to complete.
3. Click Next on the Welcome screen

**FIGURE A-16** LicenseManager Setup: Welcome.

4. Read and accept the License Agreement
5. Click Next.

**FIGURE A-17** LicenseManager Setup: License Agreement.

6. Accept the default destination folder, or select a different one.
7. Click Next.
8. In the Ready to Install the Program dialog, click Back to review or change any of the installation settings. When you are ready to continue, click Install.
9. Wait while the installation completes.
10. If you want to launch LicenseManager after completing the installation, mark the *Launch AccessData LicenseManager* check box.

![LicenseManager Setup: Completed](image)

11. Select the *Launch AccessData LicenseManager* check box to run the program upon finishing the setup.

12. Click *Finish* to finalize the installation and close the wizard.

**STARTING LICENSEMANAGER**

**To launch LicenseManager**

1. Launch LicenseManager in any of the following ways:
   - Execute `LicenseManager.exe` from `C:\Program Files\AccessData\Common Files\AccessData LicenseManager\`.
   - Click *Start > All Programs > AccessData > LicenseManager > LicenseManager*.
   - Click or double-click (depending on your Windows settings) the *LicenseManager* icon on your desktop.
   - From some AccessData programs, you can run LicenseManager from the *Tools > Other Applications* menu. This option is not available in PRTK or DNA.

When starting, LicenseManager reads licensing and subscription information from the installed and connected WIBU-SYSTEMS CodeMeter Stick, or Keylok dongle.

If using a Keylok dongle, and LicenseManager either does not open or displays the message, “Device Not Found”

1. Make sure the correct dongle driver is installed on your computer.
2. With the dongle connected, check in Windows Device Manager to make sure the device is recognized. If it has an error indicator, right click on the device and choose Uninstall.
3. Remove the dongle after the device has been uninstalled.
4. Reboot your computer.
5. After the reboot is complete, and all startup processes have finished running, connect the dongle.
6. Wait for Windows to run the Add New Hardware wizard. If you already have the right dongle drivers installed, do not browse the internet, choose, “No, not this time.”
7. Click Next to continue.
8. On the next options screen, choose, “Install the software automatically (Recommended)
9. Click Next to continue.
10. When the installation of the dongle device is complete, click Finish to close the wizard.
11. You still need the CodeMeter software installed, but will not need a CodeMeter Stick to run LicenseManager.

If using a CodeMeter Stick, and LicenseManager either does not open or displays the message, “Device Not Found”

1. Make sure the CodeMeter Runtime 4.20b software is installed. It is available at www.accessdata.com/support. Click Downloads and browse to the product. Click on the download link. You can Run the product from the Website, or Save the file locally and run it from your PC. Once the CodeMeter Runtime software is installed and running, you will see a gray icon in your system tray:.
2. Make sure the CodeMeter Stick is connected to the USB port. When the CmStick is then connected, you will see the icon change to look like this:.

If the CodeMeter Stick is not connected, LicenseManager still lets you to manage licenses using a security device packet file if you have exported and saved the file previously.

To open LicenseManager without a CodeMeter Stick installed

1. Click Tools > LicenseManager.
   LicenseManager displays the message, “Device not Found”.
2. Click OK, then browse for a security device packet file to open.

Note: Although you can run LicenseManager using a packet file, AccessData products will not run with a packet file alone. You must have the CmStick or dongle connected to the computer to run AccessData products that require a license.

Using LicenseManager

LicenseManager provides the tools necessary for managing AccessData product licenses on a WIBU-SYSTEMS CodeMeter Stick security device, a Keylok dongle, a Virtual Dongle, or in a security device packet file.

LicenseManager displays license information, allows you to add licenses to or remove existing licenses from a dongle or CmStick. LicenseManager, and can also be used to export a security device packet file. Packet files can be saved and reloaded into LicenseManager, or sent via email to AccessData support.

In addition, you can use LicenseManager to check for product updates and in some cases download the latest product versions.

LicenseManager displays CodeMeter Stick information (including packet version and serial number) and licensing information for all AccessData products. The Purchase Licenses button connects directly to the AccessData website and allows you to browse the site for information about products you may wish to purchase. Contact AccessData by phone to speak with a Sales Representative for answers to product questions, and to purchase products and renew licenses and subscriptions.

The LicenseManager Interface

The LicenseManager interface consists of two tabs that organize the options in the LicenseManager window: the Installed Components tab and the Licenses tab.
THE INSTALLED COMPONENTS TAB

The Installed Components tab lists the AccessData programs installed on the machine. The Installed Components tab is displayed in the following figure.

FIGURE A-19  LicenceManager Installed Components

![Image of LicenceManager Installed Components](image)

The following information is displayed on the Installed Components tab:

**TABLE A-1  LicenceManager Installed Components Tab Features**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Lists all AccessData products installed on the host.</td>
</tr>
<tr>
<td>Installed Version</td>
<td>Displays the version of each AccessData product installed on the host.</td>
</tr>
<tr>
<td>Newest Version</td>
<td>Displays the latest version available of each AccessData product installed on the host. Click Newest to refresh this list.</td>
</tr>
<tr>
<td>Product Notes</td>
<td>Displays notes and information about the product selected in the program list.</td>
</tr>
<tr>
<td>AccessData Link</td>
<td>Links to the AccessData product page where you can learn more about AccessData products.</td>
</tr>
</tbody>
</table>

The following buttons provide additional functionality from the Installed Components tab:

**TABLE A-2  LicenceManager Installed Components Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Opens the LicenceManager Help web page.</td>
</tr>
<tr>
<td>Install Newest</td>
<td>Installs the newest version of the programs checked in the product window, if that program is available for download. You can also get the latest versions from our website using your Internet browser.</td>
</tr>
<tr>
<td>Newest</td>
<td>Updates the latest version information for your installed products.</td>
</tr>
<tr>
<td>About</td>
<td>Displays the About LicenceManager screen. Provides version, copyright, and trademark information for LicenceManager.</td>
</tr>
<tr>
<td>Done</td>
<td>Closes LicenceManager.</td>
</tr>
</tbody>
</table>
Use the Installed Components tab to manage your AccessData products and stay up to date on new releases.

**The Licenses Tab**

The Licenses tab displays CodeMeter Stick information for the current security device packet file and licensing information for AccessData products available to the owner of the CodeMeter Stick, as displayed in the following figure.

**Figure A-20 LicenseManager Licenses Tab**

The Licenses tab provides the following information:

**Table A-3 LicenseManager Licenses Tab Features**

<table>
<thead>
<tr>
<th><strong>Column</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Shows the owned licenses for AccessData products.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Shows the date on which your current license expires.</td>
</tr>
<tr>
<td>Status</td>
<td>Shows these status of that product's license:</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: the product license is not currently owned</td>
</tr>
<tr>
<td></td>
<td>• <strong>Days Left</strong>: displays when less than 31 days remain on the license.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: the license is permanently owned. This generally applies to Hash</td>
</tr>
<tr>
<td></td>
<td>Tables and Portable Office Rainbow Tables.</td>
</tr>
<tr>
<td>Name</td>
<td>Shows the name of additional parameters or information a product requires for its license.</td>
</tr>
<tr>
<td>Value</td>
<td>Shows the values of additional parameters or information a product contained in or required for its license.</td>
</tr>
<tr>
<td>Show Unlicensed</td>
<td>When checked, the License window displays all products, whether licensed or not.</td>
</tr>
</tbody>
</table>
The following license management actions can be performed using buttons found on the License tab:

**TABLE A-4  License Management Options**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove License</td>
<td>Removes a selected license from the Licenses window and from the CodeMeter Stick or dongle. Opens the AccessData License Server web page to confirm success.</td>
</tr>
<tr>
<td>Refresh Device</td>
<td>Connects to the AccessData License Server. Downloads and overwrites the info on the CodeMeter Stick or dongle with the latest information on the server.</td>
</tr>
<tr>
<td>Reload from Device</td>
<td>Begins or restarts the service to read the licenses stored on the CodeMeter Stick or dongle.</td>
</tr>
<tr>
<td>Release Device</td>
<td>Click to stop the program reading the dongle attached to your machine, much like Windows’ Safely Remove Hardware feature. Click this button before removing a dongle. This option is disabled for the CodeMeter Stick.</td>
</tr>
<tr>
<td>Open Packet File</td>
<td>Opens Windows Explorer, allowing you to navigate to a .PKT file containing your license information.</td>
</tr>
<tr>
<td>Save to File</td>
<td>Opens Windows Explorer, allowing you to save a .PKT file containing your license information. The default location is My Documents.</td>
</tr>
<tr>
<td>Finalize Removal</td>
<td>Finishes the removal of licenses in the unbound state. Licenses must be unbound from the CmStick or dongle before this button takes effect.</td>
</tr>
<tr>
<td>View Registration Info</td>
<td>Displays an HTML page with your CodeMeter Stick number and other license information.</td>
</tr>
<tr>
<td>Add Existing License</td>
<td>Allows you to bind an existing unbound license to your CodeMeter Stick, through an internet connection to the AccessData License Server.</td>
</tr>
<tr>
<td>Purchase License</td>
<td>Brings up the AccessData product page from which you can learn more about AccessData products.</td>
</tr>
<tr>
<td>About</td>
<td>Displays the About LicenseManager screen. Provides version, copyright, and trademark information for LicenseManager.</td>
</tr>
<tr>
<td>Done</td>
<td>Closes LicenseManager.</td>
</tr>
</tbody>
</table>

**OPENING AND SAVING DONGLE PACKET FILES**

You can open or save dongle packet files using LicenseManager. When started, LicenseManager attempts to read licensing and subscription information from the dongle. If you do not have a dongle installed, LicenseManager lets you browse to open a dongle packet file. You must have already created and saved a dongle packet file to be able to browse to and open it.

**To save a security device packet file**

1. Click the *Licenses* tab, then under License Packets, click *Save to File.*
2. Browse to the desired folder and accept the default name of the .PKT file; then click *Save.*

**Note:** In general, the best place to save the .PKT files is in the AccessData LicenseManager folder. The default path is C:\Program Files\AccessData\Common Files\AccessData LicenseManager.  

**To open a security device packet file**

1. Select the *Licenses* tab.
2. Under License Packets, click *Open Packet File.*
3. Browse for a dongle packet file to open. Select the file and click Open.

**FIGURE A-21** LicenseManager Open Packet File

**ADDING AND REMOVING PRODUCT LICENSES**

On a computer with an Internet connection, LicenseManager lets you add available product licenses to, or remove them from, a dongle.

To move a product license from one dongle to another dongle, first remove the product license from the first dongle. You must release that dongle, and connect the second dongle before continuing. When the second dongle is connected and recognized by Windows and LicenseManager, click on the Licenses tab to add the product license to the second dongle.

**REMOVING A LICENSE**

To remove (unassociate, or unbind) a product license

1. From the Licenses tab, mark the program license to remove.
   This action activates the Remove License button below the Program list box.
2. Click Remove License to connect your machine to the AccessData License Server through the internet.
3. When you are prompted to confirm the removal of the selected license(s) from the device, click Yes to continue, or No to cancel.

**FIGURE A-22** LicenseManager Confirm License Release
4. Several screens appear indicating the connection and activity on the License Server, and when the license removal is complete, the following screen appears.

**FIGURE A-23** LicenseManager Packet Update Successful

5. Click OK to close the message box.

Another internet browser screen appears from LicenseManager with a message that says, “The removal of your license(s) from Security Device was successful!” You may close this box at any time.

### Adding a License

**To add a new or released license**

1. From the Licenses tab, under Browser Options, click *Add Existing License*.

The AccessData LicenseManager Web page opens, listing the licenses currently bound to the connected security device, and below that list, you will see the licenses that currently are not bound to any security device. Mark the box in the Bind column for the product you wish to add to the connected device, then click *Submit*.

2. An AccessData LicenseManager Web page will open, displaying the following message, “The AccessData product(s) that you selected has been bound to the record for Security Device nnnnnnn within the Security Device Database.

   “Please run LicenseManager’s “Refresh Device” feature in order to complete the process of binding these product license(s) to this Security Device.” You may close this window at any time.

**FIGURE A-24** LicenseManager: Associate Successful?

3. Click *Yes* if LicenseManager prompts, “Were you able to associate a new product with this device?”

4. Click *Refresh Device* in the Licenses tab of LicenseManager. Click *Yes* when prompted.

**FIGURE A-25** LicenseManager: Continue Updating Security Device?
You will see the newly added license in the License Options list.

**Adding and Removing Product Licenses Remotely**

While LicenseManager requires an Internet connection to use some features, you can add or remove licenses from a dongle packet file for a dongle that resides on a computer, such as a forensic lab computer, that does not have an Internet connection.

If you cannot connect to the Internet, the easiest way to move licenses from one dongle to another is to physically move the dongle to a computer with an Internet connection, add or remove product licenses as necessary using LicenseManager, and then physically move the dongle back to the original computer. However, if you cannot move the dongle—due to organization policies or a need for forensic soundness—then transfer the packet files and update files remotely.

**Adding a License Remotely**

To remotely add (associate or bind) a product license

1. On the computer where the security device resides:
   1a. Run LicenseManager.
   1b. From the Licenses tab, click Reload from Device to read the dongle license information.
   1c. Click Save to File to save the dongle packet file to the local machine.

2. Copy the dongle packet file to a computer with an Internet connection.

3. On the computer with an Internet connection:
   3a. Remove any attached security device.
   3b. Launch LicenseManager. You will see a notification, “No security device found”.
   3c. Click OK.
   3d. An “Open” dialog box will display. Highlight the .PKT file, and click Open.
   3e. Click on the Licenses tab.
   3f. Click Add Existing License.
   3g. Complete the process to add a product license on the Website page.
   3h. Click Yes when the LicenseManager prompts, “Were you able to associate a new product with this dongle?”
   3i. When LicenseManager does not detect a dongle or the serial number of the dongle does not match the serial number in the dongle packet file, you are prompted to save the update file, [serial#].wibuCmRaU.
   3j. Save the update file to the local machine.

4. After the update file is downloaded, copy the update file to the computer where the dongle resides:

5. On the computer where the dongle resides:
   5a. Run the update file by double-clicking it. ([serial#].wibuCmRaU is an executable file.)
   5b. After an update file downloads and installs, click OK.
   5c. Run LicenseManager.
   5d. From the Licenses tab, click Reload from Device to verify the product license has been added to the dongle.
Removing a License Remotely

To remotely remove (unassociate, or unbind) a product license

1. On the computer where the dongle resides:
   1a. Run LicenseManager.
   1b. From the Licenses tab, click Reload from Device to read the dongle license information.
   1c. Click Save to File to save the dongle packet file to the local machine.

2. Copy the file to a computer with an Internet connection.

3. On the computer with an Internet connection:
   3a. Launch LicenseManager. You will see a notification, “No security device found”.
   3b. Click OK.
   3c. An “Open” dialog box will display. Highlight the .PKT file, and click Open.
   3d. Click on the Licenses tab.
   3e. Mark the box for the product license you want to unassociate; then click Remove License.
   3f. When prompted to confirm the removal of the selected license from the dongle, click Yes.
   3g. When LicenseManager does not detect a dongle or the serial number of the dongle does not match the serial number in the dongle packet file, you are prompted save the update file.
   3h. Click Yes to save the update file to the local computer.
   3i. The Step 1 of 2 dialog details how to use the dongle packet file to remove the license from a dongle on another computer.
   3j. Save the update file to the local machine.

4. After the update file is downloaded, copy the update file to the computer where the dongle resides.

5. On the computer where the dongle resides:
   5a. Run the update file by double-clicking it. This runs the executable update file and copies the new information to the security device.
   5b. Run LicenseManager
   5c. On the Licenses tab, click Reload from Device in LicenseManager to read the security device and allow you to verify the product license is removed from the dongle.
   5d. Click Save to File to save the updated dongle packet file to the local machine.

6. Copy the file to a computer with an Internet connection.

Updating Products

You can use LicenseManager to check for product updates and download the latest product versions.

Checking for Product Updates

To check for product updates, on the Installed Components tab, click Newest. This refreshes the list to display what version you have installed, and the newest version available.

Downloading Product Updates

To install the newest version, mark the box next to the product to install, then click Install Newest.
**Note:** Some products, such as FTK 2.x, Enterprise, and others, are too large to download, and are not available. A notification displays if this is the case.

**To download a product update**

1. Ensure that LicenseManager displays the latest product information by clicking the Installed Components tab. Click **Newest** to refresh the list showing the latest releases, then compare your installed version to the latest release.
   
   If the latest release is newer than your installed version, you may be able to install the latest release from our Website.

2. Ensure that the program you want to install is not running.

3. Mark the box next to the program you want to download; then click **Install Newest**.

4. When prompted, click **Yes** to download the latest install version of the product.

   4a. If installing the update on a remote computer, copy the product update file to another computer.

5. Install the product update. You may need to restart your computer after the update is installed.

**Purchasing Product Licenses**

Use LicenseManager to link to the AccessData Web site to find information about all our products.

Purchase product licenses through your AccessData Sales Representative. Call 801-377-5410 and follow the prompt for Sales, or send an email to sales@accessdata.com.

**Note:** Once a product has been purchased and appears in the AccessData License Server, add the product license to a CodeMeter Stick, dongle, or security device packet file by clicking **Refresh Device**.

**Sending a Dongle Packet File to Support**

Send a security device packet file *only* when specifically directed to do so by AccessData support.

**To create a dongle packet file**

1. Run LicenseManager

2. Click on the Licenses tab.

3. Click **Load from Device**.

4. Click **Refresh Device** if you need to get the latest info from AD’s license server.

5. Click **Save to File**, and note or specify the location for the saved file.

6. Attach the dongle packet file to an e-mail and send it to: 

   support@accessdata.com.

**Virtual CodeMeter Activation Guide**

**Introduction**

A Virtual CodeMeter (VCM) allows the user to run licensed AccessData products without a physical CodeMeter device. A VCM can be created using AccessData License Manager, but requires the user to enter a Confirmation Code during the creation process.
The latest revision of this guide can be found at:

**PREPARATION**

- Contact your AccessData sales rep to order a VCM confirmation code.
- Install CodeMeter Runtime 4.10b or newer (available on the AccessData download page).
- Install the latest release of License Manager (available on the AccessData download page).
- The following steps are to be run on the system where you want to permanently attach the VCM.
  
  **Note:** Once created, the VCM cannot be moved to any other system.

- AD LAB WebUI and eDiscovery administrators, please also follow steps outlined under in “Additional Instructions for AD LAB WebUI and eDiscovery” on page 63 in order to enable VCM licensing on the AccessData License Service.

**SETUP FOR ONLINE SYSTEMS**

**To setup a Virtual CodeMeter**

1. Unplug any AccessData dongles you currently have connected.

2. Launch License Manager.

   **Note:** When creating a VCM on Windows Server 2003 or 2008, please refer to the special set of steps written for those platforms. See “Creating a Virtual CM-Stick with Server 2003/2008 Enterprise Editions” on page 62.

3. Select Create A Local Virtual CMStick

   ![Create A Local Virtual CMStick](image)

4. Click OK.
The Confirmation Code Required dialog appears.

**FIGURE A-27** Virtual CodeMeter Setup: Confirmation Code Required

5. Enter your confirmation code.
6. Click OK, AccessData License Manager will automatically synchronize with the License Server over the Internet.
7. Click OK when the update completes. License Manager will then create the VCM on your system.
8. At this point, AccessData License Manager now displays a serial number for the VCM on the Licenses tab and the VCM can now operate in a similar way to a hardware CodeMeter device.

**SETTING UP VCM FOR OFFLINE SYSTEMS**

You can setup a Virtual CodeMeter on a system that is not connected to the internet (offline). You must also have one machine that connects to the internet to perform certain steps. This section details what to do on which machine.

**Perform these steps on the Online system**

1. Unplug any AccessData dongles you currently have connected.
2. Launch License Manager.
3. Select *Create Empty Virtual CMStick (offline)*.

**FIGURE A-28** Virtual CodeMeter Setup: Create Empty Virtual CMStick (offline)

4. Click OK.
5. The resulting dialog prompts you to save the *.wibucmrau* file. Enter a name and path for the file, then click *Save.*
6. Transfer the *.wibucmr au to the Online system.

**Perform these steps on the Online system**

7. Unplug any AccessData dongles you currently have connected.
8. Launch License Manager.
9. Select *Create Activation File (online)*.

**FIGURE A-29** Virtual CodeMeter Setup: Create Activation File (online)

10. Click OK.

   The Confirmation Code Required dialog appears.
11. Enter your confirmation code and click OK.
12. AccessData License Manager will automatically synchronize with the License Server over the internet. Data synchronized from the server will be written to the *.wibucmr au file. Click OK when the update completes.
13. Transfer *.wibucmr au back to the offline system.

**Perform these steps on the Offline system**

14. Unplug any AccessData dongles you currently have connected.
15. Launch License Manager.
16. Select *Create Activate Virtual CMStick (offline)*.

**FIGURE A-30** Virtual CodeMeter Setup: Activate Virtual CMStick (offline)

17. Click OK.
The resulting dialog prompts you to browse to the location of the newly updated *.wibucmrau file. Locate the file, then click Open. License Manager creates the VCM on your system.

19. At this point, AccessData License Manager should now display a serial number for the VCM on the "Licenses" tab and the VCM can now operate in a similar way to a hardware CodeMeter device.

**Creating a Virtual CM-Stick with Server 2003/2008 Enterprise Editions**

This section contains special instructions for using a VCM with Windows Server 2003 or 2008 Enterprise Editions. Complete each section in order.

**To Create an Empty CodeMeter License Container**

2. Open the CodeMeter Control Center. Make sure the window on the License tab is empty indicating that no licenses are currently loaded.
3. Select File > Import License.
4. Browse to the License Manager program files directory.
   - 32 bit systems: C:\Program Files\AccessData\LicenseManager\  
   - 64 bit systems: C:\Program Files (x86)\AccessData\LicenseManager\  
5. Highlight the TemplateDisc5010.wbb file, then click Import.
6. Click the Activate License button.
7. When the CmFAS Assistant opens, click Next.
8. Select Create license request, and click Next.
9. Confirm the desired directory and filename to save .WibuCmRaC. (Example: Test1.WibuCmRaC)
10. Click Commit.
11. Click Finish.

**To Copy to another machine**

1. Copy the new .WibuCmRaC to another machine that is not running Windows Server 2003/2008 Enterprise.
   
   **Note:** The destination system must have an active internet connection.
2. Unplug any AccessData dongles you currently have connected.
3. Launch License Manager.
4. Select *Create Activation File (online)*.

**FIGURE A-31** Virtual CodeMeter Setup: Create Activation File (online)

5. Click **OK**.

6. In the Confirmation Code Required dialog enter your confirmation code and click **OK**.

7. AccessData License Manager will automatically synchronize with the License Server over the internet. Data synchronized from the server will be written to the *.wibucmrau file. Click **OK** when the update completes.

**To Finish the activation on the Windows Server 2003/2008 Enterprise system**

3. Open the CodeMeter Control Center. Make sure the window on the License tab empty indicating that no licenses are currently loaded.
4. Select **File > Import License**.
5. Browse to the location where the activated .WibuCmRaC is stored. Click **Import**.
6. AccessData License Manager now displays a serial number for the VCM on the Licenses tab and the VCM can now operate in a similar way to a hardware CodeMeter device.

**Additional Instructions for AD Lab WebUI and eDiscovery**

This section provides additional information for enabling the Web User Interface to recognize a VCM.

**To enable AD Lab WebUI and eDiscovery to use VCM**

1. Open Registry Editor.
2. Navigate to the following key:
   
   HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Products

3. Add the following DWORD registry string to the key and set the value to 1:
The AccessData License Service will know to expect a VCM when `EnableACTTest` is set to "1."

**Virtual CodeMeter FAQs**

**Q:** How do I get a Virtual CodeMeter (VCM)?

**A:** Contact your AccessData product sales representative. They will provide you with a VCM confirmation code.

**Q:** How do VCMs work?

**A:** A VCM operates in almost exactly the same way as a hardware CodeMeter device, except that they exist as a file stored on the hard disk. During activation, the VCM file (named with a WBB extension) is tied to the hardware of the system using unique hardware identifiers. Those unique identifiers make VCMs non-portable. When AccessData License Manager is launched, it will automatically load the VCM and display its license information. From there, you can refresh, remove, add existing licenses, etc just the same you would with a hardware security device.

**Q:** Are VCMs supported on virtual machines (VM)?

**A:** No. Due to the fact that virtual machines are portable and VCMs are not, VCMs are not supported on virtual machines. Currently it is recommended to use AccessData Network License Service (NLS) to license systems running as virtual machines. CLICK HERE for more information.

**Q:** Does the AccessData Network License Service (NLS) support VCMs?
A: The current release of NLS does not support using VCM as a network dongle. AccessData is considering this support for a future release.

Q: How can I “unplug” a VCM?
A: If you want to prevent License Manager from automatically loading the VCM you can "unplug" it by stopping the CodeMeter Runtime Service server and then moving (cut and paste) the WBB file to a new location (renaming the file does not suffice). By default the WBB file is located at:

32 bit systems:
C:\Program Files\CodeMeter\CmAct\n
64 bit systems:
C:\Program Files (x86)\CodeMeter\CmAct\n
Q: I have activated a VCM on my system, but now I need to activate it on a different system. What should I do?
A: Since a VCM is uniquely tied to the system on which it is activated, it cannot be moved to any other system. If you need to activate a VCM on a different system, you need to contact your AccessData Sales Representative.

Q: What if I need to reinstall Windows, format my drive, change my system's hardware, or back up my VCM in case of a disaster? Will the VCM still work?
A: The VCM can be backed up by simply copying the WBB file to a safe location. It can be restored by copying the WBB file to the CmAct folder. The VCM cannot be restored without a WBB file. If you do not have a back up of your WBB file, you will need to get a new confirmation code from your AccessData Sales Representative.

Q: My AccessData product does not seem to recognize the license stored on a VCM. What am I doing wrong?
A: VCMs are supported by the following versions of AccessData products:

- FTK 1.81.6 and newer
- FTK 3.1.0 and newer
- PRTK 6.5.0 and newer
- DNA 3.5.0 and newer
- RV 1.6.0 and newer
- eDiscovery 3.1.2 and newer
- AD Lab 3.1.2 and newer
- AD Enterprise 3.1.0 and newer
- MPE+ 4.0.0.1 and newer

Ensure that the version of the product you are running support VCMs. If the version you are running is listed as supported, verify that according to License Manager, the release date of the version you are running falls before the expiration date of the license.
**Network License Server (NLS) Setup Guide**

**Introduction**

This section discusses the installation steps and configuration notes needed to successfully setup an AccessData Network License Server (NLS).

*Note:* Click on this link to access the latest version of this guide:

[Network License Server (NLS) Setup Guide](#)

**Preparation Notes**

- CodeMeter Runtime 3.30a or newer must be installed on all Client and Server systems
- AccessData License Manager must be used to prepare the network dongle. The system running License Manager must have internet access and have CodeMeter Runtime installed.
- The current release of NLS supports the following versions of Windows:
  - Windows XP 32/64 bit
  - Windows Server 2003 32/64 bit
  - Windows Vista 32/64 bit
  - Windows Server 2008 R1 32/64 bit
  - Windows 7 32/64 bit
  - Windows Server 2008 R2 64 bit

**Setup Overview**

**To setup NLS**

1. Download the latest release of NLS located in the utilities section of the AccessData download page.
2. Extract contents of ZIP to a folder of your choice.
3. On the NLS server system, run through the NLS Installation MSI and accept all defaults.
4. Prepare network dongle:
   - 4a. Provide the serial number to AD Support and request to have the “Network Dongle Flag” applied.
   - 4b. Migrate any additional licenses to the network dongle
   - 4c. Refresh the network dongle device using AccessData License Manager.
5. Launch the AccessData product on the NLS client system.
6. Enter the NLS server configuration information:
   - IP address or hostname of NLS server system
   - Port 6921
7. Click, OK.

If you encounter any problems, please read the notes below for troubleshooting information.
**NETWORK DONGLE NOTES**

- AccessData License Manager 2.2.6 or newer should be installed in order to manage licenses on the network dongle.
- Network dongles can hold up to 120 physical licenses. Each License has a capacity to hold thousands of sub licenses (i.e. Client count or worker count).
- Contact AccessData Technical Support to have your CodeMeter device flagged as a Network Dongle (required for NLS).

**NLS SERVER SYSTEM NOTES**

- Make sure the CodeMeter device is flagged as Network Dongle (i.e. License Manager will show the serial as "1181234N". To have this flag set on your CodeMeter device, please contact AccessData Technical Support).
- Server system must be configured to allow incoming and outgoing traffic on TCP port 6921.
- A web interface to view and revoke licenses all licenses is accessible at http://localhost:555
  This page can be reached only from a web browser running locally on the NLS server system.
- A Network Dongle cannot be used to run AccessData products locally unless the NLS server is running locally.
- Some versions of Windows may not find a local NLS server when the DNS hostname of the server is provided. In those cases, it is recommended to use a static IP address.
- When using the NLS across domains, users must have permissions to access resources on both domains (either by dual-domain membership or cross-domain trust).
- When running NLS on Windows Server 2008, Terminal Services must be installed and accepting connections. If Terminal Services is not configured it will not open the port and share out the licenses correctly.
- The name of the service according to Windows is “AccessData Network License Service.”

**NLS CLIENT SYSTEM NOTES**

- When launched, any NLS client application that needs to lease a license from the NLS server will automatically check for the following values within the Windows Registry.

**FIGURE A-34** Windows Registry Editor: AccessData NetDonglePath Key

- **NetDonglePath**: The IP address or DNS hostname of the system hosting the Network License Server service which is found in the following registry key on the client system: HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Products\Common
- **NetDonglePort**: The TCP port number through which the client and server systems have been configured to use. This value is located in the same key as NetDonglePath.

- **uniqueId**: In order to lease a license from the server, the client system must first possess a unique identification value. This value is automatically generated by applications such as FTK 3, PRTK, or DNA. (Registry Viewer and FTK 1.x cannot be used setup initial client NLS configuration at this time.) You can find the each client system's uniqueId by inspecting the following registry key:

  HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Shared

- The Client system must be configured to allow all incoming and outgoing traffic on TCP port 6921.

- The following products support the ability to lease a license from a NLS server:
  - FTK 2.2.1 and newer
  - FTK 1.81.2 and newer
  - FTK Pro 3.2 and newer
  - PRTK 6.4.2 and newer
  - DNA 3.4.2 and newer
  - Registry Viewer 1.5.4 and newer
  - AD Enterprise 3.0.3 and newer
  - AD Lab 3.0.4 and newer
  - AD Lab Lite 3.1.2 and previous
  - Mobile Phone Examiner 3.0 and newer
  - Explicit Image Detection (EID) Add-on
  - Glyph Add-on

- Use AccessData License Manager (ver. 2.2.4 or newer) to migrate licenses off other devices and onto a network device.

- When running AccessData products on Windows Vista, 7, or Server 2008 you must choose **Run as administrator** at least once in order to lease a license from a NLS server.

- If the NLS client application is having trouble leasing a license either from the NLS server, AccessData recommends that you reset the licensing configuration to default.

- To reset the licensing configuration, delete and recreate the NLS registry key located at:

  HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Products\Common